


Certification Prep Series
by D. Michael Ploor
Certification Prep Series consists of individual guides that provide practice in the 
basic skills needed to be successful using the corresponding software. No previous 
software experience is required. Although the guides focus on learning skills, not 
test taking, users that complete the practice will be prepared to take the official 
software certification exam and exhibit workplace readiness. Step-by-step instructions 
demonstrate actual software commands and features, building from basic to advanced. 
Content is divided into small units for better learning and usage. There is no need to 
purchase additional materials as all lesson content is created using the software.

•	 Provides an affordable way to prepare for industry certification versus other methods.
•	 Integrates easily into existing classroom activities.
•	 Focuses on hands-on experience to develop skills.
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Introduction
The Common Occupational Readiness Essentials (CORE) series of certifi cation 
preparation guides focuses on mastering the essential basic skills needed as 
a workplace-ready user of the software. The goal of each CORE certifi cation 
preparation guide is to provide practice in each essential basic skill required by 
employers who use the software. To prove workplace readiness, you will also be 
prepared to take the offi cial certifi cation exam for the software.

CORE Microsoft Access 2013 will help prepare you to take the Microsoft Offi ce Specialist 
(MOS) Microsoft Access 2013 certifi cation exam. It provides step-by-step instruction for 
the features and commands covered on the certifi cation exam. The focus of the lessons 
is to practice using the actual commands and features instead of creating a complete 
end product. Additionally, all lesson content is created using the software. The only fi les 
that need to be downloaded are for the certifi cation simulation at the end of this guide. 
Furthermore, each certifi cation preparation guide is broken down into small learning 
units to enable better comprehension and application of the software. Where required, 
answers are provided at the back of the certifi cation preparation guide.

Certifi cation as a Microsoft Offi ce Specialist demonstrates an aptitude with 
Microsoft Offi ce software. MOS certifi cation is offered for Microsoft Word, 
Microsoft Excel, Microsoft PowerPoint, Microsoft Outlook, Microsoft Access, 
Microsoft SharePoint, and Microsoft OneNote. Certifi cation exams are provided by 
Certiport, Inc., through various testing facilities. Visit www.certiport.com for more 
information on registering for certifi cation exams.

About the Author
D. Michael Ploor is the author of the CORE series of certifi cation preparation guides. 
Mr. Ploor’s students have achieved exceptional results with the CORE certifi cation 
preparation guides. His students collectively pass more than 500 industry certifi cation 
exams each year without the need for other preparation materials. Mr. Ploor has 
demonstrated the strength of integrating the CORE guides in a diverse mix of courses.

Mr. Ploor is also the author of three textbooks on the subject of video game 
design: Introduction to Video Game Design, Video Game Design Foundations, and 
Video Game Design Composition. He is a National Board Certifi ed Teacher in Career 
and Technical Education and holds an MBA degree from the University of South 
Florida. He maintains professional teaching credentials in Business Education and 
Education Media Specialist.

Mr. Ploor is at the forefront of innovative teaching and curriculum. He developed 
STEM curriculum while serving as the lead teacher in the Career Academy of 
Computer Game Design at Middleton Magnet STEM High School. Mr. Ploor 
has applied his skills as a STEM Curriculum Integration Specialist in designing 
innovative curriculum and by collaborating to construct the state standards for 
video game design in several states. He has also been instrumental in authoring 
competitive events for Career and Technical Student Organizations such as the 
Future Business Leaders of America (FBLA) and Phi Beta Lambda (PBL).

In addition to publishing textbooks and lessons, Mr. Ploor provides professional 
development as a frequent presenter at regional and national conferences to 
promote CTE education and video game design curriculum.
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Lesson 2
Tables and Data Types

Objectives
Students will create a datasheet table. Students will set the primary key for a table. 
Students will specify data types in a table. Students will add lookup fi elds to a 
table. Students will copy and paste fi elds. Students will enter data into a table. 
Students will create an input mask. Students will add a note or memo to a table.

How to Begin
 1. Launch Microsoft Access, and click Blank Desktop Database, as shown in 

Figure 2-1. 

Click to begin defining
a new, blank database

Figure 2-1.

Creating a blank database fi le.

Access 2013.indd   15Access 2013.indd   15 1/22/2015   1:48:48 PM1/22/2015   1:48:48 PM



16  CORE Microsoft Access 2013

Copyright Goodheart-Willcox Co., Inc.

 2. In the dialog box that is displayed, click in the File Name text box, and enter 
Electives. This is the name of the database fi le.

 3. Click the browse button (folder icon) to the right of the File Name text box. A 
standard open dialog box is displayed.

 4. Navigate to your working folder,

 5. Click the OK button to set the save location.

 6. Click the Create button. A blank database is built and automatically saved in 
the location specifi ed. That is why the database save location must be specifi ed 
before clicking the Create button. When the database fi le is built, it contains a 
default table named Table1.

 7. Click the close button (X) on the far right of the Table1 tab to close the table. Do 
not close Access.

 8. To the left of where the table was removed is the Navigation Pane. This pane 
stays docked to the left side of Access and displays all the parts and documents 
of the database.

 9. Click the Shutter Bar Open/Close Button to close the shutter bar and hide the 
Navigation Pane. The Navigation Pane is on the left side of the screen. When the 
shutter bar is closed, there is more working area on the screen.

 10. Click the Shutter Bar Open/Close Button again to open the shutter bar and show 
the Navigation Pane. Notice it is easy to hide and show this pane by closing or 
opening the shutter bar.

 11. Applying what you have learned, hide the Navigation Pane.

Creating a New Table
Tables are the most essential document for a database. Tables store all of the raw 
data that will be used for the other database documents.

 12. Click the Table Design button in the Table group on the Create tab of the ribbon. 
A new table, named Table1, is opened in the workspace below the ribbon. This 
is the design view, and the Design on-demand tab is available and active, as 
shown in Figure 2-2.

 13. Click in the fi rst cell in the Field Name column, add the text Student Number, and 
press the [Enter] key. When the [Enter] key is pressed, the cell in the Data Type 
column is activated.

Shutter Bar 
Open/Close Button

Shutter Bar 
Open/Close Button

Table Design

Design
on-demand tab

Field names are column
headings in the table

Define the
data type

Figure 2-2.

Adding fi elds to the table in design view.
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 24. Click the File tab. The view displayed by clicking the File tab is called the 
backstage view, which contains commands for managing fi les, data about fi les, 
and Access options. Click Save in the backstage view. The Save As dialog box is 
displayed for saving the table.

 14. Click the drop-down arrow in the cell in the Data Type column, and click 
AutoNumber in the drop-down menu. This data type limits the input for this 
fi eld value in the table to a numerical value and also automatically numbers 
each record. Remember, the data type must match the requirement of the fi eld 
to maintain data integrity. A student number is numerical.

 15. Click the General tab in the Field Properties area at the bottom of the screen. The 
options in the Field Properties area allow the database designer to better defi ne 
the data type and to apply formatting.

 16. Click in the text box for the New Values property. Notice that a drop-down 
arrow appears on the far right, as shown in Figure 2-3.

 17. Click the drop-down arrow, and click Random in the drop-down menu. This 
setting means fi eld values in the fi eld will be automatically numbered, but not 
in any pattern. A setting of Increment means the fi eld values will be sequentially 
increased by 1 (1, 2, 3, 4, etc.).

 18. Click in the text box for the Format property, click the drop-down arrow, and 
examine number formats available, such as currency. Click General Number in 
the drop-down menu.

 19. Click in the text box for the Indexed property, click the drop-down arrow, and 
click Yes (No Duplicates) in the drop-down menu. “No duplicates” means each 
fi eld value will be unique.

 20. Click in the text box for the Text Align property, click the drop-down arrow, and 
click Left in the drop-down menu.

 21. Leave all other properties in the Field Properties area at the defaults. That means 
do not change any of the other property settings.

 22. Click in the fi rst cell in the Description column, and enter Unique ID.

 23. Add these fi eld names in the next rows: Last Name, First Name, Grade Level, Birth 
Date, Gender, Elective Choice 1, Elective Choice 2, Elective Choice 3. Leave the data 
type for these as text; this will be modifi ed later.

TIP
In the design view, 
fi eld names are 
added in rows, 
but in the table 
these are column 
headings. Fields 
are columns in the 
table.

Current view Click to
select a value

Buttons for
changing the view

Figure 2-3.

Setting the properties for the Student Number fi eld.

TIP
If the Allow Zero 
Length property is 
set to Yes, no value 
is required for this 
entry. This may be 
done, for example, 
for a middle name 
fi eld since not 
everybody has a 
middle name.
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 25. Click in the Table Name: text box, enter Student Data, and click the OK button to 
name and save the table. If a message appears asking about a primary key, click 
the No button. Notice the name of the table now appears on the document tab.

Setting the Primary Key
The student number will be unique for each record. This makes it ideal to be the 
primary key for this table.
 26. Move the cursor to the left of the fi rst row. Notice the cursor changes to an 

arrow pointing to the right. Click to select the entire row. A column can be 
similarly selected if needed.

 27. Right-click on the selected row, and click Primary Key in the shortcut menu. A key 
icon appears in the gray box to the left of the row to indicate this fi eld is the primary 
key.

Setting the Data Type
When designing a database table, it is often easiest to fi rst decide on all of the fi eld 
names and enter them. Then, after all fi eld names are entered, confi gure the data 
type for correct input for each of the fi elds.
 28. Applying what you have learned, select the second row (Last Name fi eld).
 29. Examine the options in the Field Properties area for the text data type.
 30. Modify the properties of the fi elds using the information shown in Figure 2-4.

Adding Lookup Fields
To speed up data entry and improve data integrity, it is wise to use lookup fi elds for 
data types. A lookup fi eld appears in the table in a pull-down menu or pop-up box 

Field Name Data Type Field Size* Format Required Other Property Settings

Last Name Short text 20 — Yes Allow Zero Length: No
Text Align: Left
Indexed: No

First Name Short text 20 — Yes Allow Zero Length: No
Text Align: Left

Grade Level Number Integer General 
number

Yes Decimal Places: 0

Birth Date Date and time — Short date Yes —

Gender Short text 1 — Yes —

Elective Choice 1 Short text 50 — Yes —

Elective Choice 2 Short text 50 — Yes —

Elective Choice 3 Short text 50 — Yes —

* Note: the short text data type will only support up to 255 characters.

Goodheart-Willcox Publisher
Figure 2-4.

Data to be added to the table.
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 38. Applying what you have learned, add a lookup fi eld for the Gender fi eld as a list 
box containing the values of M and F.

 39. Applying what you have learned, add a lookup fi eld for the Elective Choice 1 
fi eld containing these values: Video Game Design, Digital Design, Computer 
Applications, PE, Art, Band.

Copying and Pasting Fields
To save time building a table, you can copy and paste fi elds. All of the properties 
in the General and Lookup tabs will be copied as well. Since the choices will be the 

that will allow the value to be selected instead of manually entered. For example, 
a lookup value for the gender fi eld would allow the user to select M or F, which 
prevents the user from entering a different letter. A fi eld value can be entered by 
the user in a text box, list box, or combo box. The text box option is the default and 
allows the user to manually enter a value. This is not a lookup fi eld. The list box 
option contains values in a drop-down list from which the user must select. The 
combo box option allows the user to select a value from a drop-down list or to enter 
a value in a text box.
 31. Select any cell in the fourth row (Grade Level fi eld). Do not select the entire row, 

only the cell.
 32. Click the Lookup tab in the Field Properties area at the bottom of the screen.
 33. Click in the text box for the Display Control property, click the drop-down arrow, 

and click List Box in the drop-down list.
 34. Click in the text box for the Row Source Type property, and click Value List in the 

drop-down list. A value list limits the user input to values that appear in a list.
 35. Click in the text box for the Row Source property. Notice an ellipsis button (…) 

appears at the far right of the text box, as shown in Figure 2-5. Click the ellipsis 
button. The Edit List Items dialog box is displayed, as shown in Figure 2-6. This 
is where values to appear in the list are entered.

 36. Enter the values 9, 10, 11, and 12 on separate lines in the Edit List Items dialog 
box. Each line will be displayed as a selection option in the list.

 37. Leave the Default Value: text box blank, and click the OK button to create the 
list. Notice how the list is constructed in the Row Source property text box: 
“9”;“10”;“11”;“12”. The list may be manually created using this format instead of 
using the Edit List Items dialog box.

Select the type
of lookup field

Select the
type of list

Click to create the list
Figure 2-5.

Adding a lookup fi eld to a fi eld and specifying the contents of the list.

TIP
A default value, 
such as 9, could 
be entered in the 
Default Value: 
text box, but that 
would increase 
the likelihood of 
a data input error. 
Only set a default 
value if a fi eld has 
a standard default 
value.
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same for all three electives, copying and pasting 
is the most effi cient method for completing the 
remaining two elective fi elds.

 40. Applying what you have learned, select the 
seventh row (Elective Choice 1 fi eld).

 41. Right-click on the selected row, and click Copy 
in the shortcut menu.

 42. Applying what you have learned, select the 
eighth row (Elective Choice 2 fi eld).

 43. Right-click on the selected row, and click Paste 
in the shortcut menu.

 44. Change name of the pasted fi eld to Elective 
Choice 2.

 45. Applying what you have learned, paste the copied fi eld into the ninth row 
(Elective Choice 3 fi eld), and rename the pasted fi eld to Elective Choice 3.

Data Entry
There are different views that can be displayed. So far, you have been working in 
the design view. Data for the table can be entered using the datasheet view.
 46. Click the arrow below the View button in the Views group on the Design 

on-demand tab of the ribbon, and click Datasheet View in the drop-down menu 
that is displayed. If prompted to save the fi le, click the Yes button. The view 
changes to display the fi elds as columns, as shown in Figure 2-7.

 47. Click in the fi rst cell in the Last Name fi eld, add your last name, and press the 
[Enter] key. Notice that as soon as the fi rst character is added, the value in the 
Student Number fi eld is automatically assigned as a random number

 48. Enter your fi rst name in the First Name fi eld.
 49. Click in the fi rst cell in the Grade Level fi eld, add the text Ninth, and press the 

[Enter] key. An error message is displayed indicating the entry does not match 
the data type. Recall, the data type for this fi eld is numerical. Also recall this 
fi eld is set up as a lookup fi eld.

 50. Click the drop-down arrow in the cell in the Grade Level fi eld, and click 9 in the 
drop-down list. This is an example of how data integrity can be maintained.

 51. Click in the cell in the Birth Date fi eld for this record. Notice the calendar icon to 
the right of the cell. Click the calendar icon to display a minicalendar, and click 

View

Each line will
appear as a

separate value

Figure 2-6.

Specifying the contents of the list in a lookup fi eld.

Random student number
is automatically assigned

Add a
last name

Figure 2-7.

In the datasheet view, the table appears as it will to the user with the fi elds as columns and the records as rows.
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today’s date. The date entered as the fi eld value is in the format of month, day, 
and year. Entering birth date data in this format is not appropriate as in some 
cases it would take a long time to scroll through calendar pages to get to the 
correct month and year a person was born. To maintain data integrity, this fi eld 
will be modifi ed later.

 52. Applying what you have learned, use the lookup fi eld in the Gender fi eld to 
select your gender.

 53. Applying what you have learned, use the lookup fi elds in the Elective Choice 1, 
Elective Choice 2, and Elective Choice 3 fi elds to select Video Game Design. Notice 
that part of the fi eld value is cut off (not visible). The widths of these fi elds need 
to be modifi ed.

 54. Move the cursor between the column headers for Elective Choice 1 and Elective 
Choice 2. The cursor changes into a resizing cursor that looks like vertical bar 
with horizontal arrows, as shown in Figure 2-8.

 55. Double-click between the column headers when the resizing cursor is 
displayed. The column to the left of the cursor is automatically resized to the 
width of the widest fi eld value.

 56. Applying what you have learned, resize all fi elds as needed to fully display content.
 57. Change the Elective Choice 2 fi eld value to Computer Applications. Notice this fi eld 

value is wider than the fi eld.
 58. Resize the Elective Choice 2 fi eld to fully display its content.

Creating an Input Mask
An input mask is a pattern that will place data in the correct places. This is helpful 
when entering phone numbers and dates. The format for a phone number might be 
(123) 456-7890. The input mask for a phone number would be (_ _ _) _ _ _-_ _ _ _.
 59. Click the arrow below the View button in the Views group on the Home tab or 

the Fields on-demand tab of the ribbon, and click Design View in the drop-down 
menu that is displayed. If prompted to save the fi le, click the Yes button.

 60. Applying what you have learned, select the fi fth row (Birth Date fi eld).
 61. Click the General tab in the Field Properties area.
 62. Click in the text box for the Input Mask property, and click the ellipsis button 

(…) at the far right of the text box. If prompted to save the fi le, click the Yes 
button. The Input Mask Wizard is displayed, as shown in Figure 2-9.

View

Cursor for resizing
fields (columns)

Field value
is cut off

Figure 2-8.

Resizing the width of a fi eld.
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 63. In the Input Mask: area, click Short Date in the 
list.

 64. Click in the Try It: text box, and enter a date. 
Notice how the format is a fi ll-in-the-blank style.

 65. Click the Finish button to apply the input mask. 
Notice how the mask is entered in the Input 
Mask property text box.

Adding Notes to a Table
Since a database can be modifi ed by many different 
users, it is often a good idea to create a notes or 
memo section in the table. While a short text data 
type is limited to 255 characters, a long text data 
type does not have a limit.

 66. Applying what you have learned, display the 
datasheet view. 

 67. Create a second record for your best friend. To 
start a new record, click in any cell in the row 
containing the text (New). Choose three different 
electives.

 68. Click the column header to the right of the 
Elective Choice 3 fi eld that states Click to Add. A 
drop-down menu is displayed for selecting a 
data type, as shown in Figure 2-10.

 69. Click Short Text in the drop-down menu.

 70. The fi eld name is active for renaming. Enter 
Notes, and click in any cell in the fi eld to accept 
the name.

 71. Click the Fields on-demand tab in the ribbon. 
Notice the Field Size text box in the Properties 
group on the tab displays 255, which is the 
character limit for the fi eld value. This is the 
same property available on the Properties tab in 
the design view. Note: you may need to switch 
to design view and back to datasheet view for 
the value to be visible in the datasheet view.

 72. In the datasheet view, locate the Data Type: 
property in the Formatting group on the Fields 
tab. The data type is currently set to short text.

 73. Click the Data Type: drop-down arrow, and click Long Text in the drop-down 
menu. Notice that the Field Size property in the Properties group is now grayed 
out. This is because there is no length restriction on the long text data type. 
Note: you may need to switch to design view and back to datasheet view for the 
property to be grayed out in the datasheet view.

 74. In the Notes fi eld for your personal record, add this text: This student is a 
wonderful person.

 75. Save your work, and close Access.

Select a
format

Enter a date to
test the mask

Figure 2-9. 

Creating an input mask for a date.

Select a
data type

Click to
add a
new field

Figure 2-10.

Adding a new fi eld in the datasheet view.
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Answers

Lesson 1
Activity 1-1

 1. Home

 2. Create or Database Tools

 3. External Data 

 4. Database Tools

 5. File

 6. External Data

 7. Create

 8. Home

 9. File

 10. Database Tools

 11. Create

 12. Home

 13. File

 14. External Data

 15. Database Tools

 16. Database Tools

 17. File

 18. Home

 19. Database Tools

 20. Home

 21. External Data

 22. Create

 23. Create

 24. Database Tools

 25. File

 26. Home

 27. External Data

 28. Database Tools

 29. Create

 30. Home

Activity 1-2

 1. Visual Basic; Opens the Visual Basic editor

 2. Report Design; Creates a blank report in 
design view

 3. E-mail; Used to send objects via e-mail

 4. Advanced Filter Options; Displays advanced 
fi lter options

 5. Report Wizard; Runs the report wizard for 
creating simple customized reports

 6. Find; Finds text in the database

 7. Export to Text File; Exports the selected object 
to a text fi le

 8. Object Dependencies; Shows other objects in 
the database that use the selected object

 9. Font Color; Changes the text color

 10. Form Design; Creates a new blank form in 
design view

 11. Saved Exports; Allows running of previous 
export operations

 12. Cut; Removes the selected content and places 
it on the system clipboard

 13. Blank Report; Creates a blank report for 
designing the report from scratch

 14. Relationships; Defi nes relationships between 
data

 15.  Export Selected Object to an XML File; 
Exports an XML fi le

 16. Offi ce Links; Specifi es a table or query as the 
data source for a mail merge in Microsoft 
Word

 17. Italic; Italicizes the selected text

 18. Macro; Allows adding logic to the database by 
automating repetitive tasks

 19. Application Parts; Inserts a portion of a 
database

 20. Import Excel Spreadsheet; Imports data from 
an Excel spreadsheet or links to the those data

Review Questions

 1. Database management software.

 2. An organized collection of related data.

 3. Each student has a datum related to grade 
level.

 4. Tables, queries, forms, and reports.

 5. The Create tab.

 6. Stores data about one kind of item in columns 
and rows.
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